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ABSTRAK

Sistem pemantauan berbasis jaringan internet merupakan sistem pemantauan yang bertujuan
agar pemantauan level air didalam tangki dapat dilakukan dari tempat manapun tanpa
terkendala jarak dan kondisi apapun. Dengan memanfaatkan jaringan atau koneksi dari
intenet, alat yang telah dirancang dapat terhubung ke setiap user dimanapun berada asalkan
user terhubung dengan jaringan atau koneksi internet. pemantauan bisa di aplikasikan
langsung, menggunakan web dengan memasukkan ip address (internet protocol)
mikrocontroller ke web browser explorer. Dibutuhkan parameter sebagai dasar acuan level
air di dalam tangki dan nyala atau tidak nya pompa. Dengan mengambil dua acuan tersebut
diharapkan dapat memberikan hasil yang maksimal.sehingga dapat menghindari level
rendah dan level tinggi air di dalam tangki. Dalam perancangan ini telah berhasil di buat
alat pemantauan level air berbasis jaringan internet,dan telah dilakukan penelitian dengan
tinggi level air yang bisa di aplikasikan berkisar dari 30 cm sampai 200 cm. Menggunakan
sensor ultrasonik sebagai parameter level air di dalam tangki, program yang terhubung ke
jaringan, yang diinput kedalam mikrocontroller agar bisa di akses dari web browser, router
wirelles untuk broadcast ip ke semua network agar alat dan pemantau bisa terkoneksi, dan
pompa air yang di aplikasikan secara otomatis agar level air tidak surut.

Kata Kunci : arduino,sensor ultrasonic, web browser, java script, ehernet shield



ABSTRACT

Internet-based network monitoring system is a monitoring system that aims to monitor the
water level in the tank can be done from any place without constrained distance and any
conditions. By utilizing a network or connection from the intenet, the tool has been designed
to connect to any user wherever located as long as the user is connected to the network or
internet connection. monitoring can be applied directly, using the web by entering ip address
(internet protocol) microcontroller to web browser explorer. It takes the parameter as the
reference base of the water level in the tank and the flame or not its pump. Taking these two
references is expected to provide maximum results. So as to avoid low levels and high levels
of water in the tank. In this design has been successfully made leverage monitoring
equipment based on internet network, and has done research with high water level that can
be applied ranging from 30 cm to 200 cm. Using ultrasonic sensors as water level
parameters in the tank, the program is connected to the network, which is input into the
microcontroller in order to be accessed from the web browser, wirelles router to broadcast ip
to all networks so that devices and monitors can be connected, and water pumps that are
applied automatically to prevent the water level from receding.

Keywords: arduino, ultrasonic sensor, web browser, java script, ehernet shield
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BAB |
PENDAHULUAN

1.1 Latar Belakang

Sistem pemantauan berbasis jaringan internet merupakan salah satu bentuk
pemantauan terhadap suatu plant yang di operasikan dari tempat yang jauh. Sistem ini
banyak digunkan dalam penerapannya pada sektor dunia industri. Hal tersebut dilakukan
untuk mengetahui Kinerja dari suatu plant. Tujuannya dari pelaksanaan sistem ini agar
dapat dilakukan fungsi monitoring dan tanpa harus langsung melihat ke plant di lapangan.
Perkembangan teknologi dibidang pengontrolan dewasa ini, memungkinkan manusia untuk
menciptakan sistem HMI (Human Monitoring Interface) untuk memonitoring suatu plant.
Salah satu teknologi yang paling banyak digunakan dan sebagai hardware pendukung
sistem HMI adalah PLC (Programmable Logic Controller), namun harga untuk
membuat suatu sistem HMI masih dibutuhkan dana yang terbilang cukup mahal, untuk
mendapatkan perangkat software dan hardware pendukungnya. Maka dalam tugas akhir ini
akan dicoba untuk membuat sebuah sistem HMI dari sebuah sistem plant yang telah dibuat
sebelumnya. Sistem HMI akan dibuat dengan biaya yang murah Kkarena tidak
menggunakan PLC sebagai hardware pendukungnya, melainkan menggunakan
Mikrokontroler Arduino Mega ADK yang dimodifikasi layaknya seperti PLC, untuk
software pendukungnya menggunakan internet explorer, dalam Pemantauan nya via web

browser.



1.2
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Rumusan Masalah

Adapun masalah yang akan dibahas dalam skripsi ini adalah :

Bagaimana merancang sistem pemantauan level air ditangki berbasis jaringan internet
?

Bagaimana menganalisa sistem pemantauan level air ditangki berbasis jaringan

internet?

Tujuan Perancangan
Maksud dan tujuan yang diharapkan dalam perancangan ini adalah :
Merancang sistem pemantauan level air ditangki berbasis jaringan internet.

Menganalisa sistem pemantauan level air ditangki berbasis jaringan internet.

Batasan Masalah

Untuk memfokuskan permasalahan dalam penulisan skripsi ini, batasan- batasan

masalah yang diambil sebagai berikut :

1.

1.5

BAB |

Hanya membahas tipe mikrokontroler arduino R3 dan kelengkapan tambahan yang
terpakai di alat rancangan.

Metode penghubungan dari rancangan ke pemantau memakai tcp/ip dalam sistem
jaringan lan dan wireless.

Untuk pengaplikasian lebih menitik beratkan ke pemantauan tangki/tandon air.
Pemantauan saat ini baru dapat di jalankan di pc/laptop menggunakan browser

internet explorer.

Sistematika Penulisan
Adapun sistematika penulisan skripsi ini adalah sebagai berikut :

Pendahuluan



BAB II

BAB Il

BAB IV

BAB V

Menjelaskan latar belakang pemilihan judul, permasalahan, batasan masalah,
tujuan penelitian, dan sistematika penulisan dalam skripsi.

Tinjauan Pustaka

Tinjauan pustaka yang memberikan konsep-konsep dan teori-teori yang
menjadikan landasan dalam kegiatan penelitian.

Metodologi Penelitian

Menentukan lokasi dan memaparkan langkah metode penelitian yang digunakan
untuk menganalisis data yang diperoleh dan menggabungkan dengan rancangan
alat yang dibuat.

Pengujian dan Analisa Rancangan

Membahas pengujian dan hasil perancangan sebagai kelengkapan dalam
perancangan sistem pemantauan tangki/tandon air berbasis jaringan internet.
Penutup

Berdasarkan hasil rangkuman penelitian yang telah dilakukan maka dapat diambil

kesimpulan dan saran yang bermanfaat bagi pengembangan ilmu pengetahuan.



BAB Il
TINJAUAN PUSTAKA

2.1 Tinjauan Pustaka Relevan

Menurut Girsang Irma Sika (Skripsi FISIKA Instrumentasi FMIPA -USU),
berdasarkan Jurnal “Perancangan Monitoring Jarak Jauh Ketinggian Air Pada Bendungan
Menggunakan Sistem Android Via Jaringan Wi-Fi”. Dari hasil pengujian alat ini,
bahwa sensor konduktifitas mendeteksi ketinggian air pada bendungan dan dapat
dimonitoring bendungan tersebut dari jarak yang cukup jauh dengan menggunakan
sistem android via jaringan wi-fi, bahwa mikrokontroler =~ AT89S51  sebagai
pengontrol  dapat dikendalikan  dengan menggunakan program Codevision AVR
yang juga dihubungkan pada PC sehingga dapat ditampilkan visualisasi bendungan
dengan program Visual basic 6.0 dan dimonitoring dari jarak jauh menggunakan sistem
android Via jaringan wi-fi, dan alat ini mampu memonitoring ketinggian air pada
bendungan dari jarak jauh menggunakan sistem android via jaringan wi-fi.

Menurut Saktyo Yudhanto Danang (Skripsi Mahasiswa STMIK-AUB, Maret 2012)
berdasarkan Jurnal “Tandon Air Otomatis Berbasis Mikrokontroler ATMegal6”, Pengisian
tandon air secara manual memaksa orang untuk selalu waspada dalam pemantauan
tingkat ketinggian maupun penurunan level airnya. Sering kali orang lupa mematikan
pompa air apabila air sudah penuh, sehingga yang terjadi terbuang sia-sia dan secara
tidak langsung akan mengakibatkan pemborosan air. Jika hal ini terus terjadi maka bisa
dinilai kurang efektif dan kurang efisien. Secara keseluruhan alat ini dibagi
mengakibatkan pemborosan air. Jika hal ini terus terjadi maka bisa dinilai kurang efektif
dan kurang efisien. Secara  keseluruhan alat ini dibagi kedalam blok rangkaian,
yaitu masukan, unit pemroses, dan keluaran. Masukan terdiri atas Sensor air yaitu untuk
memerintahkan bagian kontroller untuk bekerja. Unit pemroses terdiri atas
Mikrokontroler ATMEGA16 dan Rele driver. Keluaran terdiri atas pompa air yang
berfungsi untuk mengaliri air dan menghentikan aliran air secara otomatis didalam
tandon air. Cara kerjanya adalah Mikrokontroler menerima input dari sensor air, kemudian
mikrokontroler memberikan sinyal ke rele driver untuk bekerja dan memerintahkan pompa
air untuk mengalirkan dan mematikan air dalam tandon air.

Berdasarkan dari 2 jurnal di atas, keunikan dan perbedaan alat ini adalah
fungsinya yang menyatukan fungsi-fungsi dari alat pada jurnal di atas, Yaitu
Memonitoring level air dan Pompa Air Listrik otomatis pada tendon. Adapun
Sistem kerja dari Rancang Bangun ini adalah Pertama Sensor ketinggian akan
mendeteksi batas tinggi, jika ketinggian air dibawah batas tinggi maka akan mengaktifkan
Pompa Air listrik. sebaliknya pompa akan tetap hidup dan mengisi sampai berada dibatas
tinggi dan pompa air akan mati, tidak hanya itu informasi mengenai Monitoring dan
Pompa Air Listrik akan ditampilkan di HP android melalui Koneksi Bluetooth.

2.2 Power Supply

Power supply adalah sebuah perangkat yang memasok energi listrik untuk satu atau
lebih beban listrik atau alat atau sistem yang berfungsi untuk menyalurkan energi listrik atau
bentuk energi jenis apapun yang sering digunakan untuk menyalurkan energi listrik. Istilah
ini paling sering diterapkan ke perangkat yang mengkonversi salah satu bentuk energi listrik
yang lain, meskipun mungkin juga merujuk ke perangkat yang mengkonversi energi bentuk
lain (misalnya, mekanis, kimia, surya) menjadi energi listrik. Sebuah catu daya diatur adalah
salah satu yang mengontrol tegangan output atau saat ini untuk nilai tertentu, nilai
dikendalikan mengadakan hampir konstan, meskipun variasi baik dalam beban arus atau
tegangan yang diberikan oleh sumber energi satu daya. Secara prinsip rangkaian power



supply adalah menurunkan tegangan AC, menyearahkan tegangan AC sehingga menjadi DC,
menstabilkan tegangan DC. Pada dasarnya power supply termasuk dari bagian power
conversion. Power conversion terdiri dari tiga macam :

1.

2.

3.

AC/DC power supply

DC/DC converter

DC/AC inverter Power supply untuk PC sering juga disebut PSU (Power Supply Unit)
PSU termasuk power conversion AC/DC.

Fungsi utamanya mengubah listrik arus bolak balik (AC) yang tersedia dari aliran listrik

(di Indonesia, PLN) menjadi arus listrik searah (DC) yang dibutuhkan oleh komponen pada
PC. Power supply diharapkan dapat melakukan fungsi berikut ini :

a)
b)

9)

Rectification: konversi input listrik AC menjadi DC.

Voltage Transformation : memberikan keluaran tegangan / voltage DC yang sesuai
dengan yang dibutuhkan.

Filtering : menghasilkan arus listrik DC yang lebih "bersih"”, bebas dari ripple ataupun
noise listrik yang lain

Regulation : mengendalikan tegangan keluaran agar tetap terjaga, tergantung

pada tingkatan yang diinginkan, beban daya, dan perubahan kenaikan temperatur kerja
juga toleransi perubahan tegangan daya input

Isolation : memisahkan secara elektrik output yang dihasilkan dari sumber input
Protection : mencegah lonjakan tegangan listrik (jika terjadi), sehingga tidak terjadi pada

output, biasanya dengan tersedianya sekering untuk auto shutdown jika hal terjadi.

Adapun salah satu rangkaian power supply dapat dilihat pada gambar 2.1
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Gambar 2.1 Rangkaian Power Supply

2.3 Pompa

Pompa adalah suatu alat yang digunakan untuk memindahkan suatu cairan dari suatu
tempat ke tempat lain dengan cara menaikkan tekanan cairan tersebut. Kenaikan tekanan
cairan tersebut digunakan untuk mengatasi hambatan-hambatan pengaliran. Hambatan-
hambatan pengaliran itu dapat berupa perbedaan tekanan, perbedaan ketinggian atau
hambatan gesek. Pada prinsipnya, pompa mengubah energi mekanik motor menjadi energi
aliran fluida. Energi yang diterima oleh fluida akan digunakan untuk menaikkan tekanan dan
mengatasi tahanan — tahanan yang terdapat pada saluran yang dilalui.
Pompa memiliki dua kegunaan utama:
1. Memindahkan cairan dari satu tempat ke tempat lainnya (misalnya air dari aquifer bawah

tanah ke tangki penyimpan air)
2. Mensirkulasikan cairan sekitar sistim (misalnya air pendingin atau pelumas yang
melewati mesin-mesin dan peralatan)

Pompa juga dapat digunakan pada proses - proses yang membutuhkan tekanan hidraulik
yang besar. Hal ini bisa dijumpai antara lain pada peralatan - peralatan berat. Dalam operasi,
mesin - mesin peralatan berat membutuhkan tekanan discharge yang besar dan tekanan isap
yang rendah. Akibat tekanan yang rendah pada sisi hisap pompa maka fluida akan naik dari
kedalaman tertentu, sedangkan akibat tekanan yang tinggi pada sisi discharge akan memaksa
fluida untuk naik sampai pada ketinggian yang diinginkan.

Pompa secara umum dapat diklasifikasikan menjadi 2 bagian yaitu pompa kerja positif
(positive displacement pump) dan pompa kerja dinamis (non positive displacement pump).

1. Pompa Kerja Positif (Positive Displacement Pump)



Disebut juga dengan pompa aksi positif. Energi mekanik dari putaran poros pompa dirubah
menjadi energi tekanan untuk memompakan fluida. Pada pompa jenis ini dihasilkan head
yang tinggi tetapi kapasitas yang dihasilkan rendah.

2. Pompa Sentrifugal (Dynamic Pump / Sentrifugal Pump)

Merupakan suatu pompa yang memiliki elemen utama sebuah motor dengan sudut impeler
berputar dengan kecepatan tinggi. Fluida masuk dipercepat oleh impeler yang menaikkan
kecepatan fluida maupun tekanannya dan melemparkan keluar volut. (Pompa sentrifugal)

2.4 Rele

Rele adalah Saklar (Switch) yang dioperasikan secara listrik dan merupakan
komponen Electromechanical (Elektromekanikal) yang terdiri dari 2 bagian utama yakni
Elektromagnet (Coil) dan Mekanikal (seperangkat Kontak Saklar/Switch). Rele menggunakan
Prinsip Elektromagnetik untuk menggerakkan Kontak Saklar sehingga dengan arus listrik
yang kecil (low power) dapat menghantarkan listrik yang bertegangan lebih tinggi. Sebagai
contoh, dengan Rele yang menggunakan Elektromagnet 5V dan 50 mA mampu menggerakan
Armature Rele (yang berfungsi sebagai saklarnya) untuk menghantarkan listrik 220V 2A
Gambar Bentuk dan Simbol Rele

Adapun gambar 2.4 a adalah gambar bentuk Rele dan Gambar 2.4 b adalah gambar
Simbol Rele yang digunakan.

Gambar 2.2 a Bentuk Rele
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Gambar 2.2 b Simbol Rele



Prinsip Kerja Rele Pada dasarnya, Rele terdiri dari 4 komponen dasar yaitu :
1. Electromagnet (Coil)

2. Armature
3. Switch Contact Point (Saklar)
4. Spring

Adapun bagian bagian rele dapat dilihat pada gambar 2.3
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Gambar 2.3 Struktur Sederhana Rele
Kontak Poin (Contact Point) Rele terdiri dari 2 jenis yaitu :
1. Normally Close (NC) yaitu kondisi awal sebelum diaktifkan akan selalu berada di posisi

CLOSE (tertutup)
2. Normally Open (NO) yaitu kondisi awal sebelum diaktifkan akan selalu berada di posisi
OPEN (terbuka)

Berdasarkan gambar diatas, sebuah Besi (Iron Core) yang dililit oleh sebuah kumparan
Coil yang berfungsi untuk mengendalikan Besi tersebut. Apabila Kumparan Coil diberikan
arus listrik, maka akan timbul gaya Elektromagnet yang kemudian menarik Armature untuk
berpindah dari Posisi sebelumnya (NC) ke posisi baru (NO) sehingga menjadi Saklar yang
dapat menghantarkan arus listrik di posisi barunya (NO). Posisi dimana Armature tersebut
berada sebelumnya (NC) akan menjadi OPEN atau tidak terhubung. Pada saat tidak dialiri
arus listrik, Armature akan kembali lagi ke posisi Awal (NC). Coil yang digunakan oleh Rele
untuk menarik Contact Poin ke Posisi Close pada umumnya hanya membutuhkan arus listrik
yang relatif kecil.

2.4.1 Sistem Pensaklaran pada Rele



Karena Rele merupakan salah satu jenis dari Saklar, maka istilah Pole dan Throw

yang dipakai dalam Saklar juga berlaku pada Rele. Berikut ini adalah penjelasan singkat
mengenai Istilah Pole and Throw :

1.

2.

Pole : Banyaknya Kontak (Contact) yang dimiliki oleh sebuah rele

Throw : Banyaknya kondisi yang dimiliki oleh sebuah Kontak (Contact)

Berdasarkan penggolongan jumlah Pole dan Throw-nya sebuah rele, maka rele dapat
digolongkan menjadi :

1.

Single Pole Single Throw (SPST) : Rele golongan ini memiliki 4 Terminal, 2 Terminal
untuk Saklar dan 2 Terminalnya lagi untuk Coil.

Single Pole Double Throw (SPDT) : Rele golongan ini memiliki 5 Terminal, 3 Terminal
untuk Saklar dan 2 Terminalnya lagi untuk Coil.

Double Pole Single Throw (DPST) : Rele golongan ini memiliki 6 Terminal, diantaranya
4 Terminal yang terdiri dari 2 Pasang Terminal Saklar sedangkan 2 Terminal lainnya
untuk Coil. Rele DPST dapat dijadikan 2 Saklar yang dikendalikan oleh 1 Coil.

Double Pole Double Throw (DPDT) : Rele golongan ini memiliki Terminal sebanyak 8
Terminal, diantaranya 6 Terminal yang merupakan 2 pasang Rele SPDT yang
dikendalikan oleh 1 (single) Coil. Sedangkan 2 Terminal lainnya untuk Coil.

Selain golongan Rele di atas, terdapat juga Rele - rele yang Pole dan Throw-nya melebihi

dari 2 (dua). Misalnya 3PDT (Triple Pole Double Throw) ataupun 4PDT (Four Pole Double
Throw) dan lain sebagainya.

Untuk lebih jelas mengenai Penggolongan Rele berdasarkan jumlah Pole dan Throw, dapat
dilihat pada gambar 2.4
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Gambar 2.4 Jenis Relay Berdasarkan Pole dan Throw

2.5 Arduino

Menurut (Feri Djuandi, 2011) Arduino adalah merupakan sebuah board minimum
sistem mikrokontroler yang bersifat open source. Didalam rangkaian board arduino
terdapat mikrokontroler AVR seri ATMega 328 yang merupakan produk dari Atmel.
Arduino uno menggunakan board mikrokontroler yang didasarkan pada ATmega328,
mempunyai 14 pin digital input dan output (6 diantaranya sebagai output PWM), 6
input analog yang merupakan osilator kristal 16 Mhz, koneksi USB, power jack, ICSP
header, dan tombol reset. Ardunio uno dapat disuplai melalui koneksi USB atau dengan
sebuah power suplay eksternal. Sumber daya dipilih secara otomatis. Suplay eksternal
(non-USB) dapat diperoleh dari sebuah adaptor AC ke DC atau battery. Adaptor dapat
dihubungkan dengan mencolokkan sebuah center-positive plug yang panjangnya 2,1
mm ke power jack dari board. Kabel lead dari sebuah battery dapat dimasukkan
dalam header/kepala pin Ground (Gnd) dan pin Vin dari konektor POWER. Memory
arduino, ATmega328 mempunyai 32 KB (dengan 0,5 KB digunakan untuk bootloader).
ATmega 328 juga mempunyai 2 KB SRAM dan 1 KB EEPROM (yang dapat dibaca dan
ditulis (RW/read and written) dengan EEPROM library).

Arduino Uno adalah board mikrokontroler berbasis ATmega328 (datasheet).
Arduino Uno memiliki 14 pin input dari output digital dimana 6 pin input tersebut dapat
digunakan sebagai output PWM dari 6 pin input analog, 16 MHZ osilator kristal,
koneksi USB, jack power, ICSP header, dan tombol reset. Untuk mendukung mikrokontroler
agar dapat digunakan cukup hanya menghubungkan board Arduino Uno ke komputer
dengan menggunakan kabel USB atau listrik dengan AC yang ke adaptor DC atau
baterai untuk menjalankankannya. Arduino Uno menggunakan ATmegal6U2 yang di
program sebagai USB - to - serial converter untuk komunikasi serial ke komputer melalui
port USB. Adapun gambar 2.5 merupakan bentuk Arduino Uno Tipe R 3.



Gambar 2.5 Bentuk Arduino Uno R3

Adapun Deskripsi dari Arduino Uno R3 dapat ditunjukan pada tabel 1.
Berikut :
Table 2.1. Deskripsi Arduino Uno

Mikrokontroler Atmega328

Tegangan pengoperasian 5V

Tegangan input yang disarankan 7-12V

Batas tegangan input 6-20V

Jumlah pin I/O digital 14 (6 diantaranya output PWM)
Jumlah pin input analog 6

Arus DC tiap pin 1/0 40 mA

Arus DC tiap pin I/0 50 mA

Memori Flash 32 KB (Atmega328), 0.5kb bootloader
SRAM 2 KB (Atmega328)

EEPROM 1 KB (Atmega328)

Clock Speed 16 Mhz

2.5.1 Pin Masukan Arduino Uno

Masing-masing dari 14 pin arduino uno data digunakan sebagai masukan
ataupun keluaran menggunakan fungsi pin Mode. Digital Write. dan digital Read. Setiap
pin beroperasi pada tegangan 5 volt. Setiap pin mampu menerima 9 atau menghasilkan
arus maksimum sebesar 40 mA dan memiliki resistor pull-up internal (diputus secara



default) sebesar 20-30 Kilo Ohm. Sebagai tambahan. Beberapa pin masukan digital

memiliki keunggulan khusus yaitu:

1. Komunikasi serial: pin 0 (RX) dan pin 1 (TX), digunakan untuk menerima
(RX) dan mengirim (TX) data secara serial.

2. External Interrupt: pin 2 dan pin 3, pin ini dapat di konfigurasi untuk memicu sebuah
interrupt pada nilai rendah, sisi naik atau turun, atau pada saat terjadi perubahan nilai.

3. Pulse-width modulation (PWM): pin 3,5,6,9,10 dan 11 menyediakan keluaran PWM 8-
bit dengan menggunakan fungsi analog Write.

4. Serial Peripheral Interface (SPI): pin 10 (SS), 11 (MOSI), 12 (MISO) dan 13 (SCK), pin
ini mendukung komunikasi SP1 dengan menggunakan SPI library.

5. LED: pin 13, terdapat built-in LED yang terhubung ke pin digital 13. Ketika pin
bernilai HIGH maka LED menyala, sebaliknya ketika pin bernilai LOW maka LED
akan padam.

Arduino Uno memiliki 6 masukan analog yang diberi label AO sampai A5, setiap pin
menyediakan resolusi sebanyak 10 bit (1024 nilai yang berbeda). Secara default pin
mengukur nilai tegangan dari ground (OV) hingga 5V, walaupun begitu
dimungkinkan untuk mengganti nilai batas atas dengan menggunakan pin AREF dan
fungsi analog Reference. Sebagai tambahan beberapa pin masukan analog memiliki fungsi

khusus yaitu pin A4 (SDA) dan pin A5 (SCL) yang digunakan untuk komunikasi Two
Wire Interface (TWI) atau Inter Integrated Circuit (12C) dengan menggunakan Wire library.

2.5.2 Fungsi Masukan Dan Keluaran Digital

Arduino memiliki 3 fungsi untuk masukan dan keluaran digital pada arduino
board, yaitu pin Mode, digital Write dan digital Read. Fungsi pin Mode meng-konfigurasi
pin tertentu untuk berfungsi sebagai masukan atau keluaran. Sintaksis untuk fungsi pin
Mode adalah sebagai berikut:
a. Pin Mode = (pin, mode)

b. Parameter: pin = angka dari pin digital yang akan dikonfigurasi

c. mode = konfigurasi yang diinginkan (INPUT, INPUT_PULLUP dan OUTPUT).
Fungsi digital Write berfungsi untuk memberikan nilai HIGH atau LOW suatu

digital pin. Sintaksis untuk fungsi digital Write adalah sebagai berikut:

a. Parameter: pin = angka dari pin digital yang akan di konfigurasi

b. value = nilai yang diinginkan (HIGH atau LOW).

c. Fungsi digital Read = bertujuan untuk membaca nilai yang ada pada pin arduino uno.



Sintaksis untuk fungsi digital Read adalah sebagai berikut:
Digital Read (pin) Parameter: pin = angka dari pin digital yang akan dibaca. Berikut

ini adalah contoh penggunaan fungsi masukan dan keluaran digital dalam sebuah program:
int ledPin = 13; // LED terhubung ke pin digital 13

int inPin = 7; // pushbutton terhubung ke pin digital 7

int val = 0; // variable untuk menyimpan sebuah nilai

void setup()

{

pinMode(ledPin, OUTPUT); // set pin digital 13 sebagai
keluaran

pinMode(inPin, INPUT); // set pin digital 13 sebagai masukan

}
void loop()

val = digitalRead(inPin); // baca nilai pin input digitalWrite(ledPin, val); // sets LED sesuai dengan nilai
val

}

2.5.3 Bahasa Dan Struktur Pemograman Arduino

Arduino board merupakan perangkat yang berbasiskan mikrokontroler. Perangkat
lunak (software) merupakan komponen yang membuat sebuah mikrokontroller dapat
bekerja. Arduino board akan bekerja sesuai dengan perintah yang ada dalam perangkat
lunak yang ditanamkan padanya. Bahasa Pemrograman Arduino adalah bahasa
pemrograman utama yang digunakan untuk membuat program untuk arduino board.
Bahasa pemrograman arduino menggunakan bahasa pemrograman C sebagai dasarnya.
Karena bahasa pemrograman arduino memiliki banyak sekali kemiripan. Setiap program
dalam arduino board terdiri dari dua fungsi utama yaitu setup dan loop. Instruksi yang
berada dalam fungsi setup dieksekusi hanya sekali, yaitu ketika arduino board pertama
kali dihidupkan. Biasanya instuksi yang berada pada fungsi setup merupakan konfigurasi
dan inisialisasi dari arduino board. Instruksi yang berada pada fungsi loop dieksekusi
berulang-ulang hingga arduino board dimatikan (catu daya diputus). Fungsi loop
merupakan tugas utama dari arduino board. Jadi setiap program  yang
menggunakan bahasa pemrograman arduino memilliki struktur sebagai berikut:

SEtTup |)

Program diatas dapat dlanaloglkan dalam bahasa C sebagal berlkut

id >(tup( id) 1 a Bal-
oid loop(void) "/ D Cotipe fungsi
int main(void) {
setup () >

while(l) {

loop () > . ulangl Tterus menerus

¥

return 0 'Abagian ini tidak akan pernah lieksekusi

¥



2.6 Software IDE Arduino

Arduino IDE adalah software yang ditulis menggunakan java dan
berdasarkan pengolahan seperti, avr- gcc, dan perangkat lunak open source lainnya (Djuandi,
2011). Arduino IDE terdiri dari:
1. Editor program, sebuah window yang memungkinkan pengguna menulis dan
mengedit program dalam bahasa processing.
2. Verify / Compiler, sebuah modul yang mengubah kode program (bahasa processing)
menjadi kode biner. Bagaimanapun sebuah mikrokontroller tidak akan bisa memahami
bahasa processing, yang dipahami oleh mikrokontroller adalah kode biner.
3. Uploader, sebuah modul yang memuat kode biner dari komputer ke dalam memori
mikrokontroller di dalam papan arduino
Adapun tampilan software ardumo dapat dilihat pada gambar 2.6

Gambar 2.6 Tampilan Software IDE Arduino
2.7 Arduino Development Environment

Arduino Development Environment terdiri dari editor teks untuk menulis kode,
sebuah area pesan, sebuah konsol, sebuah toolbar dengan tombol-tombol untuk fungsi
yang umum dan beberapa menu. Arduino Development Environment terhubung ke arduino
board untuk meng-upload program dan juga untuk berkomunikasi dengan arduino board.
Perangkat lunak yang ditulis menggunakan Arduino Development Environment disebut
sketch. Sketch ditulis pada editor teks. Sketch disimpan dengan file berekstensi ino. Area
pesan memberikan memberikan informasi dan pesan error ketika pengguna menyimpan
atau membuka sketch. Konsol menampilkan output teks dari Arduino development
environment dan  juga menampilkan pesan error ketika pengguna meng-compile sketch.
Pada sudut kanan bawah dari jendela Arduino Development Environment menunjukkan jenis
board dan port serial yang sedang digunakan. Tombol toolbar digunakan utuk mengecek
dan meng-upload sketch, membuat, membuka atau menyimpan sketch, dan menampilkan
serial monitor.

Dalam lingkungan arduino  digunakan sebuah  konsep yang disebut
sketchbook, yaitu tempat standar untuk menumpang program (sketch). Sketch yang ada pada
sketchbook dapat dibuka dari menu File > Sketchbook atau dari tombol open pada toolbar.
Ketika pertama kali menjalankan arduino development environment, sebuah direktori
akan dibuat secara otomatis untuk tempat penyimpanan sketchbook. Pengguna dapat
melihat atau mengganti lokasi dari direktori tersebut dari menu File > Preferences.
Serial monitor menampilkan data serial yang sedang dikirim dari arduino board. Untuk
mengirim data ke board, masukkan teks dan klik tombol send atau tekan enter pada
keyboard. Sebelum meng-upload program, perlu di-setting jenis board dan port serial yang
sedang digunakan melalui menu Tools > Board dan Tools > Serial Port. Pemilihan board
berguna untuk me-ngeset parameter (contohnya: kecepatan mikrokontroler dan baud rate)



yang digunakan ketika meng-compile dan meng-upload sketch. Setelah memilih board
dan port serial yang tepat, tekan tombol upload pada toolbar atau pilih menu File >
Upload. Arduino board akan me-reset secara otomatis dan proses upload akan dimulai.
Pada kebanyakan board, LED RX dan TX akan berkedip ketika program sedang
di-upload. Arduino development environment akan menampilkan pesan ketika proses
upload telah selesai, atau menampilkan pesan error. Ketika sedang meng-upload program,
arduino bootloader sedang digunakan, Arduino bootloader adalah sebuah program kecil
yang telah ditanamkan pada mikrokontroler yang berada pada arduino board. Bootloader
ini mengijinkan kita meng-upload program tanpa menggunakan perangkat keras tambahan.

2.8 Ethernet Shield

Ethernet shield digunakan sebagai penghubung Arduino Uno ke internet. Cara
penggunaan dengan mengubungkan kabel RJ45 pada Arduino Uno dan ethernet shield,
kemudian mengikuti beberapa instruksi maka Arduino Uno dapat mengakses internet
dan Local Area Network (LAN). Keduanya biasa digunakan untuk mengirim dan menerima
informasi melalui internet. Kecepatan koneksi Ethernet shield mencapai 10/100Mb dengan
koneksi melalui port Serial Peripheral Interface (SPI). Ethernet dapat menghubungkan
Arduino Uno ke internet berdasarkan penggunaan Wiznet W5100 sebagai chip pada
ethernet shield. Wiznet W5100 menyediakan sebuah jaringan yang mampu mengatur
TCP dan UDP. Ethernet shield juga memiliki tempat untuk kartu micro-SD yang dapat
digunakan untuk menyimpan data - data yang dikirim melalui internet. Selain itu juga
memiliki sebuah kontrol reset, untuk memastikan bahwa modul shield W5100 melakukan
reset dengan baik saat dinyalakan. Ethernet shield bisa juga dihubungkan dengan
perangkat elektronik lain melalui pin — pin pada bagian atas dan bawah yang sudah
tersedia papan rangkaian. Adapun tampilan depan dari Ethernet shield dapat dilihat pada
gambar 2.7

Gambar 2.7 tampak depan dari ethernet shield.

Adapun fitur-fitur yang dimiliki oleh modul ethernet yaitu sebagai berikut :
1. Memiliki keluaran ripple dan noise yang rendah sekitar 100mVpp

2. Memiliki pengaman untuk beban berlebih dan hubungan arus pendek

3. Tegangan keluaran sebesar 9 Volt

4. Memiliki efisiensi yang tinggi dalam mengkonversikan DC ke DC

o

Kecepatan koneksi 10/100Mb



6. Menggunakan antarmuka SP1 untuk koneksi dengan Arduino
7. Bekerja dengan tegangan masukan 5 Volt yang disuplai dari Arduino

Arduino berkomunikasi dengan W5100 dan kartu SD menggunakan antarmuka
SPI (Serial Peripheral Interface) yang terhubung dengan pin 10, 11, 12 dan 13 pada
masukan digital. Maka, pin — pin tersebut tidak dapat digunakan sebagai masukan atau
keluaran data. Untuk itu, karena W5100 dan kartu SD menggunakan antarmuka SPI (Serial
Peripheral Interface), maka hanya bisa menggunakan salah satunya saja. Dengan cara
mengeluarkan logika 1 pada pin 4 keluaran digital untuk mematikan kartu SD,
sedangkan untuk mematikan W5100 dengan memberikan logika 1 pada pin 10 keluaran
digital. Pada saat menjalankan ethernet shield yang sudah terhubung ke catu daya dan
kabel ethernet RJ45, maka beberapa LED akan menyala, yang terdiri dari :
1. PWR : sebagai indikasi ethernet shield menyala

2. LINK : sebagai indikasi adanya hubungan ke jaringan dan berkedip-kedip saat
ethernet menerima atau mengirim data.
3. FULLD : sebagai indikasi bahwa sambungan ke jaringan full duplex.
4. 100M : sebagai indikasi adanya sambungan ke jaringan 100Mb/s
5. RX: berkedip ketika ethernet sedang menerima data (Receive)
6. TX: berkedip ketika ethernet sedang mengirim data (Transmit)
7. COLL : berkedip ketika adanya jaringan yang tabrakan.
2.9 Sensor Ultrasonic HC-SR04
HC-SR04 adalah modul pengukur jarak dengan gelombang ultrasonik.
Ukurannya cukup kecil yaitu 43mm x 20 mm. Jarak pengukurannya antara 2-500 cm dengan
sudut pengukuran 15°. Sinyal keluaran dari HC-SR04 berupa pulsa yang

mempresentasikan jarak. Lebar pulsa bervariasi dari 150 uS sampai 25 uS. bentuk fisik
dari sensor HC-SR04. Dapat dilihat pada gambar 2.8 berikut ini.

Gambar 2.8 Bentuk Fisik Sensor Ultrasonic



Pada dasarnya HC-SRO04 terdiri dari chip pembangkit sinyal 40 KHz, sebuah
speaker ultrasonik dan mikrofon ultrasonik. Speaker ultrasonik mengubah sinyal 40-17
KHz menjadi suara, sementara mikrofon ultrasonik berfungsi sebagai  penerima
pantulan suara. HC-SR04 terdapat 4 buah pin yaitu VCC untuk catu daya HC-SR04, Trigger
sebagai input, Echo sebagai output sinyal, dan ground. Pin trigger dan echo dan dapat
langsung dihubungkan dengan mikrokontroler. HC-SR04  bekerja  dengan  cara
memancarkan sinyal ultrasonik kemudian menangkap pantulannya. Ketika ada masukan ke
pin trigger dari mikrokontroler yaitu pulsa High selama 10 uS, speaker ultrasonic
memancar 8 sinyal kotak dengan frekuensi 40 KHz. Sinyal ini akan merambat dengan
dengan kecepatan 344 m/s (atau 29 uS setiap 1cm). Kemudian selama menunggu
pantulan HC-SR04 akan menghasilkan pulsa High, pulsa ini akan berhenti Kketika
HC-SR04 menerima pantulan sinyal yang dikeluarkan dari speaker melalui mikrofon.
Maka lebar pulsa dapat mempresentasikan jarak antara HC-SR04 dengan objek.
Selanjutnya mikrokontroler mengukur lebar pulsa tersebut dan mengkonversinya dalam
bentuk jarak. Adapun bentuk sinyal yang dikirim dan diterima oleh HC-SR04 ditunjukan
pada Gambar 2.9
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Gambar 2.9 Bentuk Sinyal Pembacaan waktu HC-SR 04
Terdapat hal yang perlu diperhatikan dalam penggunaan HC-SR04 yang tidak
dapat mengukur objek yang dapat menyerap gelombang suara seperti busa atau sound
damper lainnya. Hasil pengukuran akan tidak tepat (kacau) jika permukaan objek
bergerigi dengan sudut tajam atau tidak rata. rumus menghitugn jarak pada sensor ultrasonik :
s =t (uS) / 58 jika jarak dihitung dalam cm
s =t (uS) /148 jika jarak dihitung dalam inchi
2.10 Pengukuran Level Cairan
Alat-alat Instrument yang digunakan untuk mengukur dan menunjukan tinggi
permukaan cairan dikenal dengan istilah Level. Pengukuran level adalah  yang
berkaitan dengan peralatan proses yang berbentuk kolom seperti, Tangki, Drum,
Tabung Silinder dan juga berupa kotak atu kubus. Tinggi level dapat dilihat langsung dan



diduga kedalamannya tanpa harus mengalami proses pengubahan bentuk bacaan dari hasil
pengukuran, ini dikarenakan oleh mekanisme yang secara langsung dapat diamati.
Dengan diketahuinya tinggi level maka volume dari cairan yang diukur dan dapat diketahui
bila. Pengukuran level secara visual atau secara langsung dapat dilihat dengan bantuan alat
ukur. Berikut di bawah ini beberapa contoh pengukuran :

1) Pelampung (Floating device).

Pelampung merupakan alat yang sedehana yang dapat digunakan dalam
pengukuran level. Pengukuran ini didasarkan pada suatu benda (pelampung) yang mampu
mengapung pada fluida tertentu.

2) Displacer.

Displacer merupakan alat ukur level yang diletakkan di sekitar tempat fluida
yang akan diukur dan juga dihubungkan dengan fluida yang bersangkutan. Dengan
menggunakan kaidah bejana berhubungan, maka level fluida dapat diketahui berdasarkan
batas fluida yang terdapat pada displacer yang telah diberikan suatu skala satuan tertentu.

3) Gelombang Ultrasonic.

Metode pengukuran level dengan menggunakan gelombang ultrasonic atau
gelombang suara lainnya memiliki prinsip kerja yang sama. Suatu sumber gelombang
ultrasonic diletakkan pada bagian atas suatu tangki. Gelombang ultasonic ini akan
merambat dan terpantul kembali ketika mengenai batas dua fluida yang berbeda. Adapun
macam macam pengukuran level fluida dapat dilihat pada gambar 2.10

r .

LSS W

pelampung displacer Penerapan hidrostatik dengan gelombang
ultrasonik

Gambar 2.10 Macam macam pengukuran level fluida
2.11 Konsep Dasar Jaringan Internet

Jaringan komputer adalah sebuah sistem yang terdiri atas komputer dan perangkat
jaringan lainnya yang bekerja bersama - sama untuk mencapai suatu tujuan yang sama.
Tujuan dari jaringan komputer adalah:
1. Membagi sumber daya: contohnya berbagi pemakaian printer, internet, folder,desktop
2. Komunikasi: contohnya surat elektronik, instant m

3. essaging, chatting

4. Akses informasi: contohnya web browsing



Tipe — tipe jaringan
1. WAN (Wide Area Networking)

2. MAN (Metropolitan Area Networking)
3. LAN (Local Area Networking)
1. WAN (Wide Area Networking)

Merupakan hubungan antara beberapa komputer yang sifatnya beda negara. Contohnya
adalah komputer yang berada di Indonesia berhubungan dengan komputer yang ada di
Washington DC, US

Ingonesa Singapura

2. MAN (Metropolitan Area Networking)

Merupakan hubungan antara beberapa komputer yang berbeda kota. Contohnya adalah
komputer cabang Jakarta berhubungan dengan komputer yang ada di cabang cirebon.

Q S

Jakarta Clrebon

Teknis hubungan MAN dilakukan bisa dilakukan dengan cara yang sama seperti pada WAN.
3. LAN (Local Area Networking)

Merupakan hubungan antara beberapa komputer yang letaknya tidak berjauhan dan masih
dimiliki oleh satu organisasi/institusi. LAN memiliki 4 model yaitu:

—

Mast A Host B
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a. P2P (Peer to Peer)
b. Workgroup

a. Jaringan P2P (Peer to Peer)

Adalah hubungan antar 2 komputer. Hubungan P2P ini memiliki syarat yang harus
dilakukan yaitu: Harus ada 2 komputer. Masing-masing komputer dipasang NIC (Network
Interface Card) / LAN Card. Media transmisi (kabel UTP) dan tidak boleh lebih dari 100m.
Operating system seperti Windows atau Linux. Ada TCP/IP sebagai Protokol.

b. Jaringan Workgroup

Adalah hubungan antara beberapa komputer tanpa adanya server. Workgroup ini
memiliki syarat yang hampir sama dengan P2P yaitu: Harus ada beberapa komputer (harus
lebih dari 2 komputer) yang terhubung ke switch. Masing-masing komputer dipasang NIC
(Network Interface Card) / LAN Card. Media transmisi (kabel UTP) dan tidak boleh lebih
dari 100m. Jika lebih menggunakan repeater. Menggunakan Switch / Multiple Repeater.
Operating system seperti Windows atau Linux. Ada TCP/IP sebagai Protokol.

Untuk membuat jaringan workgroup ketentuan dan langkah - langkah masih sama dengan
jaringan P2P, tetapi pada jaringan workgroup menggunakan Switch sebagai penghubung.

2.12 Pengertian Mikrotik dan Fungsinya

Mikrotik adalah sistem operasi dan perangkat lunak yang dapat digunakan untuk
menjadikan komputer manjadi router network yang handal, mencakup berbagai fitur yang
dibuat untuk IP network dan jaringan wireless, cocok digunakan oleh ISP, provider hotspot
dan warnet. Mikrotik didesain untuk mudah digunakan dan sangat baik digunakan untuk
keperluan administrasi jaringan komputer seperti merancang dan membangun sebuah sistem
jaringan komputer skala kecil hingga yang kompleks sekalipun. Belakangan ini banyak usaha
warnet yang menggunakan mikrotik sebagai routernya, dan hasilnya mereka merasa puas
dengan apa yang diberikan mikrotik. Terlebih kemajuan dunia wireless yang menyajikan
berbagai macam pelayanan mulai melirik benda yang satu ini. Adapun gambar 2.11
merupakan bentuk dari rb 951 ui. Berbagai fitur ditawarkan pada mikrotik diantaranya :
a) Firewall dan NAT

b) Routing — Static routing
c) Data Rate Management

d) Hotspot
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h)
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Point-to-Point tunneling protocols
Simple tunnels
IPsec
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Gambar 2.11 Bentuk Mikrotik RB 951 Ul
Fungsi Mikrotik

Pengaturan koneksi internet dapat dilakukan secara terpusat dan memudahkan untuk
pengelolaannya.

Konfigurasi LAN dapat dilakukan dengan hanya mengandalkan PC Mikrotik Router OS
dengan hardware requirements yang sangat rendah.

Blocking situs-situs terlarang dengan menggunakan proxy di mikrotik.

Pembuatan PPPOE Server.

Billing Hotspot.

Memisahkan bandwith traffic internasional dan local, dan lainnya.



2. Forwarding IP Local ke IP Publik

Agar Server bisa diakses dari internet, set fowarding di router mikrotik dengan fitur
firewall NAT. Fowarding ini akan membalokkan traffic yang menuju ke IP publik yang
terpasang di router menuju ke IP lokal server. Dengan begitu, seolah-olah client dari internet
berkomunikasi dengan server meminjam IP public router mikrotik. Langkah pembuatan rule,
masuk ke menu IP --> Firewall --> klik tab "NAT", tambahkan rule baru dengan menekan
tombol "add" atau tanda "+" berwarna merah. Adapun Gambar 2.12 Merupakan contoh

forwarding IP yang ada di Router Mikrotik.

New NAT Rule @ﬂ
o R
Chan. detnat * ﬂij
Sec. Address = | M ]
Det. Address: (1202120123123 ~ *70”'*7,
Protocol: | 6 4¢p) 3a [[C w J
S Poat: v [ Cooy 1
Dst. Post 80 A [ = 1‘
et | [ resacorten |
e
Action, |deax s 7Cmod —
To Addresses: 1192.168.88.10 i ool
To Pods. |80 i —

Gambar 2.12 Contoh Forwarding IP di Mikrotik

2.13 Pengertian Java Scrip

Javascript adalah bahasa yang berbentuk kumpulan skrip yang berjalan pada suatu
dokumen HTML. Bahasa ini adalah bahasa pemrograman untuk memberikan kemampuan
tambahan terhadap bahasa HTML dengan mengijinkan pengeksekusian perintah perintah di
sisi user, yang artinya di sisi browser bukan di sisi server web.

Javascript diperkenalkan pertama kali oleh Brendan Eich yang bekerja di Netscape
pada tahun 1995. Pada awalnya bahasa ini dinamakan “LiveScript” yang berfungsi sebagai
bahasa sederhana untuk browser Netscape Navigator 2. Kemudian sejalan dengan sedang
giatnya kerjasama antara Netscape dan Sun (pengembang bahasa pemrograman “Java’) pada
masa itu, maka Netscape memberikan nama “Javascript” kepada bahasa tersebut pada tanggal
4 desember 1995. Adapaun perbedaan Javascript dengan Java dapat dilihat pada tabel 2.2.
Tabel 2.2 perbedaan Javascript dengan Java



Javascript Java 0
Bahasa yang dijalankan oleh program leh

Bahasa yang dijalankan langsung eksternal (Java Virtual Machine) karena
oleh browser diintegrasikan ke dalam browser ada
— - banyak
Didefinisikan dengan tag <script> perusaha
pada halaman HTML Didefinisikan dengan tag <applet> an yang
Kode program bersifat terbuka dan mengem
dapat dibaca melalui browser Kode program dapat bersifat tertutup bangan,
Tidak memerlukan proses kompilasi Perlu kompilasi untuk menghasilkan bahasa
menjadi file lainnya file .class In!
kemudia

n distandarkan dengan nama ECMAScript oleh Netscape melalui Organisasi Internasional
ECMA. Standar ini dipublikasikan pertama kali pada bulan Juni 1997 dengan nama dokumen
Spesifikasi ECMA-262. Saat ini standar ini telah mencapai rilis Edisi ke-5.1, yang
dipublikasikan pada bulan Juni 2011. Setiap browser saat ini memiliki implementasi sendiri-
sendiri untuk ECMAScript ini, diantaranya Internet Explorer dengan JScript, Opera dengan
ECMAScript, dan Mozilla Firefox, Google Chrome termasuk juga Safari dengan nama
Javascript. Selain di browser, sekarang Javascript juga sudah diterapkan pada banyak aplikasi
lainnya seperti Windows 8 Apps (.Net Framework), Adobe Flash ActionScript, KDE Desktop
Environment, Node.js, Qt QML, JQuery Mobile, Firefox OS, Ubuntu Touch dan masih
banyak lagi kemungkinan implementasi lainnya.

Berikut ini satu tabel yang berisi beberapa perbandingan mendasar antara Java dan
Javascript.

Javascript adalah bahasa yang ‘“case sensitive” artinya membedakan penamaan
variabel dan fungsi yang menggunakan huruf besar dan huruf kecil, setiap instruksi dapat
diakhiri dengan karakter titik koma (;).

1. Penulisan Kode Javascript

Menggunakan tag <SCRIPT>

Kode javascript dalam HTML dituliskan dengan menggunakan tag <script> dengan
format sebagai berikut :

<script language="javascript’>

</script>

Menggunakan file eksternal
Cara berikutnya adalah menuliskan kode program Javascript dalam suatu file teks dan
kemudian file teks yang berisi kode Javascript di panggil dari dalam dokumen HTML
(khusus Netscape mulai versi 3 keatas). Kode yang kita sisipkan kedalam dokumen HTML
adalah sebagai berikut :
| <script language="javascript” src="lokasi/file js”></script> |

Melalui event tertentu
Event adalah sebutan dari satu aksi yang dilakukan oleh user, contohnya seperti klik tombol
mouse, pembahasan lebih lanjut ada di materi lainnya. Kodenya dapat di tulis sebagai berikut

| <tag eventHandler="kode Javascript yang akan dimasukkan"> |




2. Dokumentasi Program

Sangat dianjurkan untuk menambahkan komentar - komentar di dalam skrip atau kode
program yang dibuat untuk keperluan dokumentasi pengembangan. Hal ini berguna antara
lain :

a. sebagai pengingat bagian-bagian khusus di dalam skrip tersebut, jika akan merubah
sesuatu di dalamnya, mungkin beberapa bulan kemudian sudah tidak ingat lagi dengan detail
dan alur dari skrip tersebut.

b. untuk membuat orang yang tidak tahu program yang dibuat jadi mengerti dengan
membaca petunjuk - petunjuk yang dibuat melalui komentar-komentar.

3. Contoh program Javascript

Pada contoh berikut ini adalah contoh skrip Javascript didalam suatu dokumen HTML, disini
kita akan membuat satu program untuk menampilkan satu kotak dialog (dijelaskan lebih
lanjut di bab lainnya) pada saat kita membuka dokumen HTML file: halo.html

<htmI>

<head>

<title>contoh program javascript</title>
</head>

<body>

<script language="javascript">
alert("Hallo !");

</script>

</body>

</html>
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METODOLOGI PENELITIAN

3.1 Lokasi Penelitian
Adapun penelitian ini dilaksanakan di Laboratorium Sistem Kontrol, Program Studi
Tekhnik Elektro, Fakultas Tekhnik Universitas Muhammadiyah Sumatera Utara. JL Kapt.

Muchtar Basri No. 3 Medan.

3.2  Alat dan Bahan Rancang Bangun
Adapun alat dan bahan rancang bangun yang digunakan oleh penulis di dalam
merancang sistem pemantauan level air di tangki berbasis jaringan internet di Universitas
Muhammadiyah Sumatera Utara, yaitu :
Alat :
1. PC (Personal Computer)
2. Software IDE Arduino
Bahan :
1. Power Supply 12 Volt
2. Mikrokontroller Arduino Uno R3
3. Ethernet Shield yang Compatible dengan Arduino Uno R3
4. Sensor Ultrasonic (HC-SR04)
5. Rele 12 Volt
6. Miniatur Pompa
7. Akrilic

8. Wadah Air



9. Selang Pembuangan
3.3 Diagram Blok

Gambar 3.1 merupakan diagram blok yang dirancang. Diagram menjelaskan
konfigurasi Input/Output dan bagian — bagian yang digunakan pada sistem. Dalam hal ini

input berasal dari ketinggian air yang dideteksi oleh Sensor Ultrasonic.

CATU Arduino Ethernet RELAY
DAYA 12V Uno R3 Shield

Sensor
Ultrasonic

User / Internet

Level Air

Gambar 3.1 Diagram Blok dari Rancangan

Input lain berasal dari user melalui koneksi jaringan internet (Lan/Wirelles). Input
diproses oleh sebuah controller yaitu Arduino Uno R3 yang merupakan modul terintegrasi
dengan Input/Output standart. Sedangkan output adalah kondisi pompa yang diaktifkan oleh
controller. Sesuai kondisi level pada tangki. Modul Ethernet Shield berfungsi sebagai
perantara (Interface) antara jaringan dengan controller arduino sebagai pencatu daya
digunakan sebuah stepdown (adapter) 12 V. Untuk mensuplai komponen komponen yang

digunakan.



3.4

Diagram Alir
MULAI

1Y

A

INISIALISASI DAN
NILAI AWAL

)

BACA LEVEL TANGKI DENGAN
SENSOR ULTRASONIC

KALIBRASI NILAI
KETINGGIAN AIR

KIRIM DATA KE JARINGAN
MELALUI ETHERNET SHIELD

)

LEVEL AIR

Y

AKTIFKAN POMPA

Y

MATIKAN POMPA

A 4

T USER OFF

STOP

Gambar 3.2 Diagram Alir Rancangan




Gambar 3.2 Diagram Alir yang menggambarkan aliran kerja program yang dibuat.
Dimulai dengan inisialisasi dan nilai awal kemudian dilanjutkan dengan pembacaan level
tangki menggunakan sensor ultrasonic. Data hasil pembacaan dikalibrasi oleh program untuk
memperoleh tinggi air sebenarnya.

Proses kalibrasi data dikirim ke jaringan (broadcast) oleh Ethernet shield yang
terhubung pada jaringan lan. Kemudian program akan membandingkan ketinggian air yang
terbaca/terukur. Jika ketinggian level air dibawah 50% maka pompa akan aktif sedangkan
jika level telah mencapai diatas 90% pompa akan off proses ini berlanjut terus hingga sistem

di off kan langsung oleh user.

3.5  Perancangan Hardware
Perancangan hardware atau perangkat keras menggunakan beberapa komponen yaitu
: Power Supply, Modul Controller (Arduino), Ethernet Shiel, Sensor Ultrasonic, Rele,

Pompa. Fungsi masing-masing komponen diatas adalah sebagai berikut:

1. Power supply

Power supply yang digunakan pada rancangan ini adalah sebuah step down 220V, ke 12V
DC. Arus yang dikeluarkan adalah 1 ampere. Adaper (catu daya) digunakan untuk mensuplai
rangkaian yaitu modul controller, ethernet shield, sensor ultrasonic dan rele. Adapun bentuk

power supply/catu daya terlihat pada gambar 3.3
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Gambar 3.3 Bentuk Power Supply/Catu Daya yang digunakan

2. Sensor

Sensor yang digunakan yaitu sensor ultrasonic tipe SR-04. Fungsi sensor adalah
mendeteksi ketinggian level air dalam tangki. Cara kerja sensor adalah dengan mengirim
frequensi ultrasonic dan mendeteksi pantulan ultrasonic kemudian menghitung waktu yang
dibutuhkan untuk perjalanan ultrasonic, pergi dan kembali.

"Dengan mengetahui kecepatan suara maka dapat dihitung jarak antara sensor dengan
objek pantul. Ketinggian air dapat dibaca dengan mendeteksi jarak sensor dengan permukaan
air. Jika ketinggian sensor diketahui maka dapat dicari ketinggian air. Adapun Gambar 3.4

merupakan bentuk dari sensor ultrasonic



Gambar 3.4 Bentuk sensor Ultrasonic

3. Kontroler (Arduino)

Kontroler adalah sebuah modul terintegrasi dengan beberapa input dan output sesuai
dengan tipe arduino yang digunakan. Dalam hal ini tipe yang digunakan adalah arduino uno
r3. Arduino tipe ini menggunakan ic controller AVR yaitu Atmega 328. Controller memiliki
3 buah port 1/0 termasuk input analog dan serial. Dalam rancangan ini arduino deprogram
untuk bekerja sebagai pendeteksi ketinggian level air kemudian mengkalibrasi data sensor
untuk mendapatkan nilai sebenarnya. Data hasil proses yang digunakan sebagai pembanding
untuk mengaktifkan dan menonaktifkan pompa. Controller juga mengirim data ke jaringan
internet agar dapat diakses oleh user. Adapun Gambar 3.5 merupakan bentuk dari arduino

uno R3.



g "f'“'Fv K'\.H( >

UNO

@ .......... LR N N B N N N
.'4 AL z :

HH\

Gambar 3.5 Bentuk Arduinno Uno R3

4. Ethernet Shield

Ethernet Shield yang digunakan dipilih yang compatible dengan kontroller arduino yang
digunakan. Fungsi Ethernet Shield adalah sebagai interface (perantara) komunikasi data
rangkaian dengan jaringan internet. Ethernet Shield menggunakan protocol internet standart
dalam pengiriman dan penerimaan data melalui bus data dan bus kontroller pada modul
arduino. Adapun Gambar 3.6 merupakan bentuk dari Ethernet shiel yang digunakan

rancangan

perrr—

|A;lll .?!F

4

Gambar 3.6 Bentuk Ethernet shield yang digunakan

5. Rele



Rele yang digunakan pada rancangan adalah rele DC 12V. tipe DPDT. Fungsi rele adalah
untuk mengalirkan atau memutuskan arus ke pompa, dengan demikian rele bekerja sebagai
saklar. Rele diaktifkan oleh arduino melalui penguat (transistor)

Adapun gambar 3.7 merupakan bentuk dari rele yang digunakan.

Gambar 3.7 Bentuk Rele yang digunakan

6. Pompa

Fungsi pompa adalah memindahkan massa air dari satu titik ke titik lain. pompa akan
menghisap air kemudian menyemburkannya ke luar melalui selang perantara. Sehingga
pemindahan air dapat terjadi. Pompa yang digunakan adalah pompa celup aquarium dengan
tegangan kerja AC 220V.

Gambar 3.8 merupakan gambar pengawatan untuk perancangan sistem pemantauan level

air ditangki berbasis jaringan internet
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Gambar 3.8 Gambar Pengawatan Rancangan

3.6 Perancangan Software
Perangkat lunak merupakan program yang dibuat untuk menjalankan sistem melalui

sebuah kontroller. Program disusun berdasarkan salah satu bahasa pemrograman. Algoritma



perintah ditulis secara beraturan dan sistematis sehingga membentuk suatu urutan kerja
teratur sesuai fungsinya. Rancangan ini menggunakan bahasa pemrograman C, yaitu suatu
bentuk bahasa tingkat tinggi yang mudah dimengerti oleh manusia. Program dibuat atau
ditulis pada lingkungan pengembangan arduino (ARDUINO DEVELOPMENT
INVIRONMENT) versi 1.6.5. Dari menu file kemudian pilih new project maka program dapat
ditulis pada form yang diberikan. Setelah program selesai ditulis maka perlu di kompail
menjadi kode mesin melalui menu tool dan pilih compile, jika hasil kompail tidak terdapat
kesalahan maka program dapat diunggah dengan ke modul arduino melalui menu yang
tersedia. Tentunya setelah modul terhubung pada komputer dan driver telah terinstall dengan
baik. Program yang dibuat diperlihatkan pada gambar berikut.

#¢include <SPI.h>

$include <Ethernet.h>

#i ude <LiquidCrystal.h>
#define Select_PIN AS

int Select_PINState; // variable for reading the pushbutton status
int CLewvel,Status;
const int echoPin = 6;
const int pingPin = 7
st byte Relay = 8;

long duration,S;

// Enter a MAC address and IP address for your controller below.
// The IP address will be dependent on your local network:

byte mac[] = {0xDE, OxAD, OxBE, OxEF, OxFE, OxED };

IPAddress ip(192,168,1, 177);

/ Initialize the Ethernet server library
// with the IP address and port you want to use
/ (port 80 is default for HITP):

EthernetServer server(g0):



woid setupd() {
pinMode (pingPin, OUTPUT) :
pinMode (Relay, CUTPUT) :
pinMode {echoPin, INPUT) :
CLewvel = 07
Ethernet.begin(mac, ip):
server.begin() s

wvoid Sensor Read() {
digitalWrite (pingPin, LOW) ;>
delayMicroseconds (2) 2
digitalWrite (pingPin, HIGH)
delayMicroseconds (5) 2
digitalWrite (pingPin, LOW) >

duration = pulselIn(echoPin, HIGH)

S5 = microsecondsToCentimeters (duration) ;

Clevel = 20 — 5;

if{Clevel <« 5){ digitalWrite (Relay, HIGH):Status = 1;
if({CLevel >= 18){ digitalWrite(Relay, LOW):Status = 0
delay (500) 7

1
sl

long microsecondsToCentimeters (long microseconds)

{

return microseconds / 29 / 2;

wvoid loop() {
fF/ listen for incoming clients
EthernetClient client = server.availabkle():;

Sensor_ Read()
if (client) {
boclean currentlLineIsBlank = true;
while (client.connected(}}) {
if (clienct.available()) {
char ¢ = client.read();
Serial.write(c):



if (c == '"\n' s& currentlineIsBlank) {
// send a standard http response header
client.println("HITP/1.1 200 OK");
client.println("Content-Type: text/html");
client.println("Connnection: close");
client.println():
client.println("<'DOCTYPE HIML>");
client.println("<html>");
// add a meta refresh tag, so the browser pulls again every 5 seconds:
client.println("<meta http-equiv=\"refresh\" content=\"1\">");

client.princ(™ "):

client.println("<br />");

client.print (" Sistem Monitoring Trafo distribusi berbasis WEB ");
client.println("<br />");

client.print("™ ");

client.println("<br />"):

client.println("<br />");

client.print(" Level 0li - -
client.print (CLevel);
client.print(" cm");
client.println("<br />"):
client.println("<br />");

if (Status == 1) {client.print(" Status pompa : Aktif");}

if(Sctatus == 0) {client.princt (™ Status pompa : tidak Aktif™):}

client.println("<br />");
client.println("<br />");
client.println("</html>");

break:

}

if (¢ = "\n") {
f// you're starting a new line
currentlLinelIsBlank = true;

}

elas FF [ = Y] §
// you've gotten a character on the current line
currentlLineIsBlank = false;

}
// give the web browser time to receive the data
delay(500);

// close the connection:

client.stop():

Serial.println("client disonnected™):



BAB IV
PENGUJIAN DAN ANALISA RANCANGAN
4.1 Pengujian Rancangan
4.1.1 Pengujian dan Analisa Pada kontroler Arduino

Pengujian ic kontroler Arduino-uno dilakukan dengan mengukur tegangan tiap pin ic
tersebut dan melakukan pembandingkan dengan program yang dibuat. Tabel 4.1 Hasil
pengukuran terhadap Arduino:

pin Vout(V) Pin Vout(V)
1 5,02 15 4,99
2 0,01 16 5,02
3 0,01 17 5,01
4 0,01 18 0,01
5 0,01 19 0,02
6 0,02 20 0,01
7 5,02 21 0,01
8 0,00 22 0,01
9 2,39 23 0,01
10 0,71 24 5,01
11 0,01 25 0,01
12 0,02 26 5,01
13 0,02 27 0,01
14 5,01 28 0,00

Dari tabel diatas dapat dicari logika keluaran tiap port yaitu:
PORTB : 00001111
PORTC : 00001010
PORTD : 00000000

4.1.2 Pengujian dan Analisa pada Tranduser Ultrasonik.

Tranduser ultrasonic adalah sebuah komponen yang mengubah frekuensi listrik
menjadi frekuensi suara ultra sonik. Untuk menguji fungsi tranduser harus dengan cara
memberikan input frekuensi listrik kemudian ukur dengan alat ukur output yang diberikan
oleh tranduser.

Pada pengujian ini digunakan frekuensi yang dibuat dengan memprogram kontroler arduino
. Program dibuat agar arduino mengeluarkan frekuensi pada salah satu port. Output port
tersebut kemudian dikuatkan oleh penguat sehingga daya nya cukup untuk mendorong
tranduser. Perintah program pada arduino adalah sebagai berikut.

Void loop(void)

{
digitalWrite(PIN8,HIGH)
delayMicroseconds(12);
digitalWrite(PIN8,LOW)
delayMicroseconds(13);

¥

Berdasarkan hasil pengujian didapatkan Frekuensi yang dihasilkan sekitar 40KHz.
Dimana output suara tersebut tidak dapat didengar oleh telinga manusia. Untuk mengetahui
suara tersebut ada atau tidak dibutuhkan lah sebuah alat ukur. Alat ukur yang digunakan
untuk pengukuran tersebut adalah sound level meter. SLM diarahkan pada output tranduser



kemudian amati tampilan pada display. Agar didapatkan hasil pengukuran yang akurat, alat
tersebut membutuhkan kondisi, tempat uji harus senyap atau sepi sehingga tidak ada suara
lain yang mengganggu. Pada saat level air rendah maka level suara akan naik dan begitu juga
sebaliknya jika pada saat level air tinggi maka level suara akan turun.

4.1.3. Pengujian dan Analisa pada catu daya 12V dan 5V.

Pengujian catu daya 12V dan 15V dilakukan untuk mengetahui kemampuan tegangan
catu daya dengan cara di beri beban dan tanpa beban. Adapun hasil dari pengukuran dapat
dilihat pada tabel 4.2
Tabel 4.2 Data hasil pengukuran yang dilakukan :

Output Regulator
Tanpa Beban 129V 5,02V
Dengan Beban 12,2V 5,00V

Berdasarkan tabel 4.2 didapatkan ada perbedaan tegangan catu daya. Catu daya
mengalami jatuh tegangan yang tidak signifikan antara berbeban dengan tanpa beban baik
untuk 12V maupun 5V.

4.1.4. Pengujian dan Analisa pada Ethernet Shield

Pengujian dilakukan secara langsung pada perangkat keras ethernet shield dan
mengamati kinerja alat tersebut apakah sesuai dengan yang diharapkan atau tidak. Pengujian
melibatkan modul kontroler yang digunakan yaitu modul arduino uno yang telah diprogram
untuk fungsi tersebut yaitu menjalankan sistem sebagai pengirim data informasi level tangki
pada jaringan internet. Jika berhasil dijalankan dan alat bekerja dengan baik maka user dapat
mengakses informasi tersebut melalui komputer dengan aplikasi internet explorer . Adapun
peralatan yang digunakan pada pengujian ini adalah sebagai berikut:

1. Modul kontroler Arduino uno tipe R3

2. Modul ethernet shield kompatibel arduino
3. Komputer PC

4. Jaringan LAN / internet

5. Kabel LAN

6. Adaptor 12V/1A

7. DII.

Pengujian ini membutuhkan program yang dibuat untuk mengakses ethernet melalui
alamat IP ( Internet Protocol ). Program tersebut dapat dilihat pada bagian lampiran yang
disertakan pada bab terakhir. Setelah program diunggah pada modul kontroler ,pengujian
dapat dimulai dengan menghubungkan semua komponen yaitu modul arduino dengan modul
ethernet, kemudian antara ethernet shield dengan jaringan LAN. Pada mulanya ,untuk
mempermudah proses pengujian kabel LAN dapat dihubungkan secara langsung pada port
LAN pada komputer. Hal ini untuk memudahkan pengujian karena tidak perlu mengatur port
atau IP pada jaringan. Tujuan nya hanya untuk menguji apakan modul ethernet yang
digunakan dapat bekerja atau tidak.

Setelah semua koneksi terhubung, kemudian aktifkan modul sistem dan komputer PC
(laptop). Untuk memulai pengujian ,user dapat membuka aplikasi internet explorer pada
komputer. Tunggu beberapa saat kemudian reset modul arduino dengan menekan tombol
reset. Setelah di reset, user dapat mengetikkan alamat IP modul ethernet. Dalam hal ini IP



yang digunakan adalah  10.10.12.93 dan untuk dari jaringan internet menggunakan
110.232.83.73 Jika berhasil maka pada tampilan explorer akan muncul keterangan “berapa
level ketinggian air dan nyala atau tidaknya pompa pengisian™ . Sedangkan jika gagal maka
tampilan pada explorer menyatakan alamat web tidak dapat dibuka.

Adapun gambar 4.1 merupakan tampilan internet explorer hasil pengujian.

' (10101383 X

€ X I(D 1010.13.93

MONITORING LEVEL AIR BERBASIS WEB

20

15

By Muhammad Al Ridho

Volume Air 16 cm

Gambar 4.1 Hasil Monitoring yang di pantau dari WEB



BAB V

PENUTUP

5. 1 Kesimpulan
Berdasarkan hasil yang telah didapat dari perancangan Sistem Pemantauan level air
di dalam tangki berbasing jaringan internet dapat di ambil kesimpulan bahwa:

1. Dalam perancangan sistem pemantauan air di dalam tangki berbasis jaringan internet.
Alat alat yang terpakai meliputi Arduino Uno R3, Ethernet Shield, Sensor Ultrasonic,
Modem atau Router. Arduino berfungsi sebagai kontroler pengolah data yang
diberikan untuk memberikan perintah ke Ethernet shield dan output dari arduino.
Ethernet Shield berfungsi sebagai penghubung antara rancangan ke jaringan internet
modem atau router. Sensor berfungsi sebagai pembaca level ketinggian air yang
terhubung ke input arduino dengan minimum dan maksimum pembacaan 20 cm — 200
cm. Modem atau Router berfungsi sebagai gateway ip dari setiap local network agar

bisa diteruskan ke public network jaringan internet.

2. Rancangan dapat bekerja ketika modul arduino diberi input tegangan 12V, setelah
modul nyala, modul arduino mulai mengeksekusi program yang telah di upload
sebelumnya. Input pembacaan yang didapat dari sensor ultrasonic, diberikan kepada
arduino dan Ethernet shield. Data yang di terima kemudian diolah oleh arduino untuk
meberikan sinyal ke Ethernet shield agar keluaran dari Ethernet shield bisa dipantau
dari browser explorer. Dan untuk menyalakan dan mematikan pompa, jika air < 50 %

pompa nyala, air > 90% pompa off.

5.2 Saran



Untuk pengaplikasiannya alat ini tidak di batasi hanya untuk memantau tangki saja.
Alat ini bisa diaplikasikan ke berbagai macam hal, contoh nya pemantauan level minyak
trafo, pemantauan level ketinggian kanal, pemantauan level ketinggian sungai, sistem on/off

saklar melalui internet, dan lain lain.

ultrasonic, diberikan kepada arduino dan Ethernet shield. Data yang di terima
kemudian diolah oleh arduino untuk meberikan sinyal ke Ethernet shield agar
keluaran dari Ethernet shield bisa dipantau dari browser explorer. Dan untuk
menyalakan dan mematikan pompa, jika air < 50 % pompa nyala, air > 90% pompa

off.

5.2 Saran

Untuk pengaplikasiannya alat ini tidak di batasi hanya untuk memantau tangki saja.
Alat ini bisa diaplikasikan ke berbagai macam hal, contoh nya pemantauan level minyak
trafo, pemantauan level ketinggian kanal, pemantauan level Kketinggian sungai, bisa

dipergunakan menjadi saklar ON/OFF dari jarak jauh dengan membuat program tambahan.



1.

6.

7.

8.

DAFTAR PUSTAKA

Irma Sika G. (2012). Perancangan Monitoring Jarak Jauh Ketinggian Air Pada
Bendungan Menggunakan Sistem Android Via Jaringan Wi-Fi. Universitas Sumatera
Utara

. Danang S Y.(2012). Tandon Air Otomatis Berbasis Mikrokontroler ATMegal6. Surakarta

. Sumiharto R. (2009). Integrasi Sensor Network Menggunakan Mikrokotroller Jaringan

Modul Evaluation Board DSTINImM400. Universitas Gajah Mada

. Dinata I, WahriSunanda. (2015). Implementasi Wirelles Monitoring Energi listrik Berbasis

Web Database. Jurusan Teknik Elektro, Fakultas Teknik Universitas Bangka Belitung

. Supatmi S, Nizar T.N, Fahlevi R. (2014). Sistem Kontrol Peralatan Rumah Dan

Monitoring Kondisi Rumah Melalui Internet Berbasis Web Dan Openwrt Jurnal Teknik
Komputer Unikom — Komputika — Volume 3, No 2 -2014

Agung H. (2014). Aplikasi Untuk Pemantauan Lan Pada Studi Kasus Di Universitas Bunda
Mulia. Jurnal Teknologi Informasi Vol 10, No 1 2014.

Widijanuarto A.S (2014). Jurus Kilat Membuat jaringan Komputer Dunia komputer.
Jakarta Timur

Putranto A. (2014). Membangun Sistim Monitoring Dan Kontrol Level Air Melalui

Saluran Telephone. Widyaiswara Departemen Elektro - PPPPTK BOE Malang



LAMPIRAN

Arduino Uno
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Arduino Uno adalah papan mikrokontroler berdasarkan ATmega328 (datasheet). Ini memiliki
14 pin input / output digital (yang 6 dapat digunakan sebagai output PWM), 6 input analog,
osilator kristal 16 MHz, koneksi USB, colokan listrik, header ICSP, dan tombol reset. Ini
berisi semua yang dibutuhkan untuk mendukung mikrokontroler; cukup hubungkan ke
komputer dengan kabel USB atau nyalakan dengan adaptor AC ke DC atau baterai untuk
memulai. Uno berbeda dari semua papan sebelumnya karena tidak menggunakan chip driver
USB-to-serial FTDI. Sebagai gantinya, fitur Atmega8U2 diprogram sebagai konverter USB-
to-serial.

"Uno" berarti satu dalam bahasa Italia dan dinamai untuk menandai rilis Arduino 1.0 yang
akan datang. Uno dan versi 1.0 akan menjadi versi referensi Arduno, bergerak maju. Uno
adalah yang terbaru dalam rangkaian papan Arduino USB, dan model referensi untuk
platform Arduino; Untuk perbandingan dengan versi sebelumnya, lihat indeks papan

Arduino.

Mikrokontroler Atmega328



Tegangan pengoperasian
Tegangan input yang disarankan
Batas tegangan input

Jumlah pin I/O digital

Jumlah pin input analog

Arus DC tiap pin 1/0

Arus DC tiap pin 1/0

Memori Flash

SRAM

EEPROM

Clock Speed

oV

7-12V

6-20V

14 (6 diantaranya output PWM)

6

40 mA

50 mA

32 KB (Atmega328), 0.5kb bootloader
2 KB (Atmega328)

1 KB (Atmega328)

16 Mhz



Arduino Ethernet Shield
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Arduino Ethernet Shield memungkinkan dewan Arduino terhubung ke internet. Hal ini
didasarkan pada chip ethernet Wiznet W5100 (datasheet). Wiznet W5100 menyediakan
sebuah jaringan (IP) stack yang mampu untuk kedua TCP dan UDP. Ini mendukung hingga
empat koneksi soket simultan. Gunakan pustaka Ethernet untuk menulis sketsa yang
terhubung ke internet menggunakan perisai. Perisai ethernet terhubung ke papan Arduino
menggunakan header wire-wrap panjang yang meluas melalui perisai. Hal ini membuat tata
letak pin tetap utuh dan memungkinkan perisai lain ditumpuk di atas.

Revisi perisai terbaru menambahkan slot kartu micro-SD, yang bisa digunakan untuk
menyimpan file untuk ditayangkan melalui jaringan. Ini kompatibel dengan Arduino
Duemilanove dan Mega (menggunakan perpustakaan Ethernet yang masuk Arduino 0019).
Sebuah perpustakaan kartu SD belum termasuk dalam distribusi Arduino standar, namun

sdfatlib karya Bill Greiman berjalan dengan baik.

Revisi sebelumnya juga mencakup pengendali ulang, untuk memastikan bahwa modul
Ethernet W5100 benar diatur ulang pada power-up. Revisi perisai sebelumnya tidak sesuai

dengan Mega dan perlu disetel ulang secara manual setelah power-up. Revisi perisai asli



berisi slot kartu SD ukuran penuh; ini tidak didukung Arduino berkomunikasi dengan kartu
W5100 dan SD dengan menggunakan bus SPI (melalui header ICSP). Ini ada pada pin digital
11, 12, dan 13 pada Duemilanove dan pin 50, 51, dan 52 pada Mega. Pada kedua papan, pin
10 digunakan untuk memilih W5100 dan pin 4 untuk kartu SD. Pin ini tidak bisa digunakan
untuk general i / 0. Di Mega, pin SS perangkat keras, 53, tidak digunakan untuk memilih
kartu W5100 atau SD, tapi harus tetap sebagai output atau antarmuka SPI tidak akan
berfungsi. Perhatikan bahwa karena kartu W5100 dan SD berbagi bus SPI, hanya satu yang
bisa aktif sekaligus. Jika Anda Menggunakan kedua periferal dalam program Anda, ini harus
ditangani oleh perpustakaan yang sesuai. Jika Anda tidak menggunakan salah satu perangkat
dalam program Anda, bagaimanapun, Anda harus secara eksplisit membatalkan pilihannya.
Melakukan Ini dengan kartu SD, atur pin 4 sebagai output dan tulislah yang tinggi untuk itu.
Untuk W5100, atur pin digital 10 sebagai a output tinggi.

Perisai ini menyediakan jack ethernet standar RJ45.

Tombol reset pada perisai me-reset kedua papan W5100 dan Arduino.

Perisai berisi sejumlah informasi LED:

1. PWR: menunjukkan bahwa papan dan perisai bertenaga

2. LINK: menunjukkan adanya link jaringan dan berkedip saat perisai mentransmisikan atau
menerima data

3. FULLD: menunjukkan bahwa koneksi jaringan adalah full duplex

4. 100M: menunjukkan adanya koneksi jaringan 100 Mb / s (berlawanan dengan 10 Mb / s)
5. RX: berkedip saat perisai menerima data

6. TX: berkedip saat perisai mengirimkan data

7. COLL: berkedip saat tabrakan jaringan terdeteksi

Jemper solder yang bertanda "INT" dapat dihubungkan untuk memungkinkan dewan Arduino

menerima pemberitahuan kejadian yang diinterupsi dari W5100, namun ini tidak didukung



oleh perpustakaan Ethernet. Jumper menghubungkan pin INT dari W5100 ke pin digital 2

dari Arduino.
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Ultrasonic Ranging Module HC - SR04

Modul mulai ultrasonik HC - SR04 menyediakan fungsi pengukuran kontak 2cm - 400cm,
ketepatan mulai bisa mencapai 3mm. Modul meliputi pemancar ultrasonik, sirkuit penerima
dan kontrol. Prinsip dasar kerja: (1) Menggunakan 10 memicu setidaknya 10us sinyal tingkat
tinggi, (2) Modul secara otomatis mengirimkan delapan 40 kHz dan mendeteksi apakah ada
sinyal pulsa kembali (3) JIKA sinyal balik, melalui tingkat tinggi, waktu keluaran tinggi 10
adalah waktu dari mengirim ultrasonik untuk kembali. Jarak uji = (waktu tingkat tinggi x
kecepatan suara (340M / S) / 2, Kawat yang menghubungkan langsung sebagai berikut: a)
Pasokan 5V b) Input Pulsa Pemicu c) Keluaran Echo Pulse d) Ground 0V

Parameter Listrik

Working Voltage DC5V

Working Current 15 mA

Working Frequency 40Hz

Max Range 4m

Min Range 2cm

MeasuringAngle 15 degree

Memori Flash Trigger Input Signal 10uS TTL pulse

Echo Output Signal Input TTL lever signal and the range in
Proportion

Dimension 45*20*15mm



Timing diagram

Diagram Timing ditunjukkan di bawah ini. Anda hanya perlu mensuplai pulsa 10uS pendek
ke input pemicu untuk memulai mulai, dan kemudian modul akan mengirimkan 8 siklus burst
ultrasound pada 40 kHz dan menaikkan gema. Echo adalah objek jarak yang merupakan lebar
pulsa dan rentang proporsinya. Anda dapat menghitung rentang melalui interval waktu antara
sinyal pemicu pengiriman dan sinyal gema penerima. Formula: uS / 58 = sentimeter atau uS /
148 = inci; atau: kisaran = kecepatan waktu tinggi * (340M / S) / 2; kami menyarankan untuk
menggunakan siklus pengukuran lebih dari 60ms, untuk mencegah sinyal pemicu sinyal

gema.

13 TTL Timing Diagram
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RB951Ui-2HnD



RB951Ui-2HnD adalah SOHO AP nirkabel dengan CPU Atheros generasi baru dan lebih
banyak kekuatan pemrosesan. Ini memiliki lima port Ethernet, satu port USB 2.0 dan power
2.4GHz 1000mW 802.11b / g / n wireless AP dengan antena built in yang memiliki CPU
600MHz, RAM 128MB dan fungsi output POE untuk port # 5 - ini bisa Power perangkat PoE
lainnya mampu dengan voltase yang sama seperti yang diterapkan pada unit. Beban
maksimum pada port adalah 500mA.

Paket berisi RouterBOARD 951Ui-2HnD dalam kotak plastik dan adaptor daya.
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Features RB951Ui-2HnD (USB, power injector, USB, 2GHz, 802.11n, dual chain)
CPU Atheros AR9344 600MHz CPU

Memory 128MB DDR2 onboard memaory

Ethernet Five independent 10/100 Ethernet ports

LEDs Power, NAND activity, 5 Ethernet LEDs, wireless activity LED

Power in PoE: 8-30V DC on Ether1 (Mon 802.3af). Jack: 8-30V DC

Power out PoE passive on port 5, same voltage as input.

Dimensions

113%x138x29mm

Weight

Without packaging and PSU: 232g, full weight in package: 420g

Power consumption

Up to 7W

Operating Temp

-20C .. +50C

Operating System

MikroTik RouterOQS, Leveld license

Package contains

RouterBOARD in a plastic case, 24V 0.8A power adapter

Antennas 2x2 MIMO PIF antennas, max gain 2.5dBi

RX sensitivity 802.11g: -96dBm @ 6Mbit/s to -80dBm @ 54Mbit/s
802.11n: -96dBm @ MCSO0 to -78dBm @ MCS7

TX power 802.11g: 30dBm @ 6Mbps to 25dBm @ 54 Mbps

802.11n: 30dBm @ MCSO0 to 23dBm @ MCS7

Modulations

OFDM: BPSK, QPSK, 16 QAM, 64QAM; DSSS: DBPSK, DQPSK, CCK




